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Introduction
X(cross) Development System is a tool that allows user to easily cross build applications.
This documentation is available :
online: http://docs.automotivelinux.org/docs/devguides/en/dev/#xcross-development-system-user's-guide
PDF file: http://iot.bzh/download/public/XDS/docs/XDS_UsersGuide.pdf
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Getting Started for Users
Abstract
X(cross) Development System (XDS) is set of tools that provide a multi-platform for cross development with near-zero installation.
This documentation is available :
online: http://docs.automotivelinux.org/docs/devguides/en/dev/#xcross-development-system-user's-guide
PDF file: http://iot.bzh/download/public/XDS/docs/XDS_UsersGuide.pdf
The first goal of XDS is to provide a multi-platform cross development tool with near-zero installation.
The second goal is to keep application sources locally (on user's machine) to make it compatible with existing IT policies (e.g.
corporate backup or SCM), and let user to continue to work as usual (use his favorite editor, keep performance while
editing/browsing sources).
The two main blocks that compose XDS:
The client part (
The server part (

Version 6.0.0
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The client part (

X(cross) Development System

xds-agent

) is portable and is running on:

Linux
Windows
MacOS
The following 3 main configurations are supported:
standalone (or local) config
On-Premise (local network)
SaaS (Cloud based)

Version 6.0.0
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Installing XDS server
Depending of your configuration, this step is necessary or not.
In other words you are a developer and plan to use/connect to an existing

xds-server

running on your local network (On-

Premise config) or in the Cloud (SaaS config), you don't need to install the server part and you can skip this step.
For others (standalone config or administrators that want to install an On-Premise solution) xds-server must be installed.
Several installation types are supported:
Install type

Supported OS

Section to refer

Container

Linux or MacOS

see Installation based on Docker container

Virtual Machine

Linux, MacOS or Windows

see Installation based on VirtualBox appliance

Native

Linux

see Native installation
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Installation based on Docker container
Docker container prerequisites
Docker is installed on the host machine, please refer to Docker documentation for more details.

Get the container
Load the pre-build AGL SDK docker image including

xds-server

:

wget -O - http://iot.bzh/download/public/XDS/docker/docker_agl_worker-xds-latest.tar.xz | docker load

You should get

image

docker.automotivelinux.org/agl/worker-xds:X.Y

# List image that we just load
docker images "docker.automotivelinux.org/agl/worker-xds*"
REPOSITORY

TAG

IMAGE ID

CREATED

SIZE

docker.automotivelinux.org/agl/worker-xds

5.0

877979e534ff

3 hours ago

106MB

Create and start a new container
Use provided script to create a new docker image and start a new container:
# Get script
wget -O xds-docker-create-container.sh 'https://gerrit.automotivelinux.org/gerrit/gitweb?p=src/xds/xds-server.git;a=blob
_plain;f=scripts/xds-docker-create-container.sh;hb=master'
# Create new XDS worker container (-id option value should be changed when you get port conflict error)
bash ./xds-docker-create-container.sh -id 0
# Check that new container is running
docker ps | grep worker-xds
f67079db4339
seconds

docker.automotivelinux.org/agl/worker-xds:5.0

"/usr/bin/wait_for..."

0.0.0.0:8000->8000/tcp,0.0.0.0:10809->10809/tcp, 0.0.0.0:2222->22/tcp

About a minute ago

Up 34

agl-xds-HOSTNAME-0-USERNAME

This container exposes following ports:
Port number
8000
2222

Description
xds-server

: serve XDS webapp and REST API

ssh

This container also creates the following volumes (shared folders between inside and outside docker):
Directory on host

Directory inside
docker

Comment

$HOME/xds-workspace

/home/devel/xdsworkspace

XDS projects workspace location

$HOME/xdsworkspace/.xdt_0

/xdt

location to store SDKs

Version 6.0.0
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$USER_VOLUME

user path, see

$USER_VOLUME

container.sh

--volume

option of

xds-docker-create-

script

Note:
You can add a new shared directory using

--volume

option in order to use for example with Path-Mapping folder type.

# Create new XDS worker container and share extra '$HOME/my-workspace' directory
bash ./xds-docker-create-container.sh --volume /my-workspace:$HOME/my-workspace

You can change docker used port with

-id

option

# Create new XDS worker container with a different port number
bash ./xds-docker-create-container.sh -id ${ID}
# Check that new container is running
docker ps | grep worker-xds
f67079db4339
seconds

docker.automotivelinux.org/agl/worker-xds:5.0

"/usr/bin/wait_for..."

About a minute ago

0.0.0.0:(2222+ID)->22/tcp, 0.0.0.0:(8000+ID)->8000/tcp, 0.0.0.0:(10809+ID)->10809/tcp

Up 34

agl-xds-HOSTNAME-I

D-USERNAME

Manually setup docker user id
Note:
If you used

xds-docker-create-container.sh

script to create XDS docker container, user uid/gid inside docker has already been

changed by this script.
If you plan to use path-mapping sharing type for your projects, you need to have the same user id and group id inside and
outside docker.
By default user and group name inside docker is set
Use following commands to replace id

1664

devel

(id

1664

).

with your user/group id:

# Set docker container name to use (usually agl-xds-xxx where xxx is USERNAME@MACHINENAME-IDX-NAME)
export CONTAINER_NAME=agl-xds-seb@laptop-0-seb
docker ps | grep -q ${CONTAINER_NAME} || echo "ERROR: No container name \"${CONTAINER_NAME}\" please set a valid CONTAIN
ER_NAME before you continue"
# First kill all processes of devel user (including running xds-server)
docker exec ${CONTAINER_NAME} bash -c "/bin/loginctl kill-user devel"
# Change user and group id inside docker to match your ids
docker exec ${CONTAINER_NAME} bash -c "usermod -u $(id -u) devel"
docker exec ${CONTAINER_NAME} bash -c "groupmod -g $(id -g) devel"
# Update some files ownership
docker exec ${CONTAINER_NAME} bash -c "chown -R devel:devel /home/devel /tmp/xds*"
# Restart devel autologin service
docker exec ${CONTAINER_NAME} bash -c "systemctl restart autologin"
# Restart xds-server as a service (ssh port 2222 may depend on your container ID)
ssh -p 2222 devel@localhost -- "systemctl --user restart xds-server"

Check if xds-server is running (open XDS webapp)
xds-server

is automatically started as a user service on container startup.
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If the container is running on your localhost, you can access to a basic web application:
xdg-open http://localhost:8000

If needed you can status / stop / start it manually using following commands:
# Status XDS server:
ssh -p 2222 devel@localhost systemctl --user status xds-server.service
# Stop XDS server
ssh -p 2222 devel@localhost systemctl --user stop xds-server.service
# Start XDS server
ssh -p 2222 devel@localhost systemctl --user start xds-server.service
# Get XDS server logs
ssh -p 2222 devel@localhost journalctl --user --unit=xds-server.service --output=cat

xds-server

is now up and running, you can now install AGL SDKs, please refer to next chapter named Installing AGL SDKs

Please refer to xds-server configuration chapter for additional info about xds-server settings.
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Installation based on Virtual Machine appliance
Virtual Machine appliance prerequisites
VirtualBox is installed on the host machine
please refer to VirtualBox documentation for more details.

Get the appliance
Load the pre-build AGL SDK appliance image including

xds-server

:

wget http://iot.bzh/download/public/XDS/appliance/xds-vm-debian9_latest.ova

Clean old appliance
You must have one and one xds appliance only.
So, first remove the oldest xds appliance if needed.
# Get the virtual machine name
VDS_VMNAME=$(VBoxManage list vms | grep xds-vm-debian | cut -d "\"" -f2)
echo ${VDS_VMNAME}
# Remove old XDS appliance
[ -n ${VDS_VMNAME} ] && VBoxManage controlvm ${VDS_VMNAME} poweroff
[ -n ${VDS_VMNAME} ] && VBoxManage unregistervm ${VDS_VMNAME} --delete

Create and start a new appliance
Used provided script to create a new appliance or you can use VirtualBox GUI:
# Import image into VirtualBox
VBoxManage import ./xds-vm-debian9_latest.ova
# Check import result
VDS_VMNAME=$(VBoxManage list vms | grep xds-vm-debian | cut -d "\"" -f2)
echo ${VDS_VMNAME}

Add share folder to appliance, mandatory to use path-mapping sharing type for projects:
# Create local share folder
mkdir -p $HOME/xds-workspace
#Add share folder to appliance
VBoxManage sharedfolder add ${VDS_VMNAME} --name XDS-workspace --hostpath $HOME/xds-workspace

Start appliance
# Start XDS appliance

Version 6.0.0
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[ -n ${VDS_VMNAME} ] && VBoxManage startvm ${VDS_VMNAME}

Appliance settings
This image exposes following network ports (NAT mode):
8000 :

xds-server

to serve XDS basic web page

2222 : ssh

Check if xds-server is running
xds-server

is automatically started as a service on container startup.

To check if xds-server is correctly install and running, you can access the basic web page that gives you some instructions:
# if container/appliance is running on your local host
# (else replace localhost by the name or the ip of the machine running the container)
xdg-open http://localhost:8000

xds-server

is now up and running, you can now install AGL SDKs, please refer to next chapter named Installing AGL SDKs
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Native installation
You can chose to install xds-server 'natively' instead of within a docker container but note that only Linux host OSes are supported
and tested for native installation !
You also need to install

python3

to allow

xds-server

to manage AGL sdks.

Install packages for debian distro type
# 'DISTRO' can be set to { xUbuntu_16.04, xUbuntu_16.10, xUbuntu_17.04, Debian_8.0, Debian_9.0}
export DISTRO="xUbuntu_16.04"
# AGL_RELEASE can be set to {AGL_ElectricEel, AGL_FunkyFlounder, AGL_Master}
export AGL_RELEASE="AGL_Master"
wget -O - http://download.opensuse.org/repositories/isv:/LinuxAutomotive:/${AGL_RELEASE}/${DISTRO}/Release.key | sudo ap
t-key add sudo bash -c "cat >> /etc/apt/sources.list.d/AGL.list <<EOF
deb http://download.opensuse.org/repositories/isv:/LinuxAutomotive:/${AGL_RELEASE}/${DISTRO}/ ./
EOF"
sudo apt-get update
sudo apt-get install agl-xds-server
# Install python3
sudo apt-get install python3

Install packages for openSUSE distro type
# DISTRO can be set to {openSUSE_Leap_42.3, openSUSE_Leap_15.0, openSUSE_Tumbleweed}
export DISTRO="openSUSE_Leap_15.0"
# AGL_RELEASE can be set to {AGL_ElectricEel, AGL_FunkyFlounder, AGL_Master}
export AGL_RELEASE="AGL_Master"
sudo zypper ar http://download.opensuse.org/repositories/isv:/LinuxAutomotive:/${AGL_RELEASE}/${DISTRO}/isv:LinuxAutomot
ive:${AGL_RELEASE}.repo
sudo zypper ref
sudo zypper install agl-xds-server
# Install python3
sudo zypper install python3

Configure xds-server
Optional step: skip this chapter if you plan to use default settings
Please refer to Configuration chapter of xds-server documentation for more details about JSON configuration file.

Start/Stop xds-server
xds-server

can be managed as a systemd service with the following commands:
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# Status XDS server:
systemctl --user status xds-server.service
# Stop XDS server
systemctl --user stop xds-server.service
# Start XDS server
systemctl --user start xds-server.service
# Get XDS server logs
systemctl --user --unit=xds-server.service --output=cat

To check if xds-server is correctly install and running, you can access the web interface, using a web browser :
xdg-open http://localhost:8000

or get the current version using the following curl command:
curl http://localhost:8000/api/v1/version
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Installing XDS client tools
xds-agent is a client tool that must run on your machine (user / developer host) to be able to use XDS.
You should establish the following chain:
XDS Client: (

xds-cli

XDS Agent: (

xds-agent

or XDS Dashboard).

XDS Server (

xds-server

) running on your machine.
) running on a remote server and/or in a container.

Exchanges between these 3 tools are done though HTTP and Websocket protocols.
Default url/port mentioned in schema below can be change using config files.

Installation of other XDS client tools, such as

xds-cli

or

xds-gdb

is optional and depends of what you want to do:

xds-cli : command line tool to used to interact with XDS (also used by IDE integration).
xds-gdb : requested for debugging application.

Install packages for debian distro type
# 'DISTRO' can be set to { xUbuntu_16.04, xUbuntu_16.10, xUbuntu_17.04, Debian_8.0, Debian_9.0 }
export DISTRO="xUbuntu_16.04"
# AGL_RELEASE can be set to {AGL_ElectricEel, AGL_FunkyFlounder, AGL_Master}
export AGL_RELEASE="AGL_Master"
wget -O - http://download.opensuse.org/repositories/isv:/LinuxAutomotive:/${AGL_RELEASE}/${DISTRO}/Release.key | sudo ap
t-key add sudo bash -c "cat >> /etc/apt/sources.list.d/AGL.list <<EOF
deb http://download.opensuse.org/repositories/isv:/LinuxAutomotive:/${AGL_RELEASE}/${DISTRO}/ ./
EOF"
sudo apt-get update
sudo apt-get install agl-xds-agent
sudo apt-get install agl-xds-cli
sudo apt-get install agl-xds-gdb

Install packages for openSUSE distro type
# DISTRO can be set to {openSUSE_Leap_42.3, openSUSE_Leap_15.0, openSUSE_Tumbleweed}
export DISTRO="openSUSE_Leap_15.0"
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# AGL_RELEASE can be set to {AGL_ElectricEel, AGL_FunkyFlounder, AGL_Master}
export AGL_RELEASE="AGL_Master"
sudo zypper ar http://download.opensuse.org/repositories/isv:/LinuxAutomotive:/${AGL_RELEASE}/${DISTRO}/isv:LinuxAutomot
ive:${AGL_RELEASE}.repo
sudo zypper ref
sudo zypper install agl-xds-agent
sudo zypper install agl-xds-cli
sudo zypper install agl-xds-gdb

Install for other platforms (Windows / MacOS)
Install

xds-agent

:

1. Download the latest released tarball from github releases page.
2. Then unzip the tarball any where into your local disk (for example:

/opt/AGL/xds

or

C:\AGL\xds

).

3. Add binary to PATH:
MacOs: create the .bash_profile

nano .bash_profile

and add

export PATH="/opt/AGL/xds/xds-agent:$PATH

Windows: change the system path via control panel or system settings or

setx path "C:\AGK\xds\xds-agent;%path%"

repeat the previous steps to install other tools depending of your needs:
xds-cli

: requested for command line and IDE integration. (released tarball link).

xds-gdb

: requested for debugging application. (released tarball link).

Start xds-agent
XDS-agent is a client tool that must run on your local / user development machine when you use XDS.
For Linux distro, a user systemd service is provided,

xds-agent.service

.

To start it automatically at boot and you can enable it using following commands:
# Enable xds-agent service at boot
systemctl --user enable xds-agent.service

To start the XDS-agent service:
# Manually start xds-agent service
systemctl --user start xds-agent.service
# Get status and log of xds-agent service
systemctl --user status xds-agent.service

On MacOS (or Linux), you can start-it manually using following commands:
/opt/AGL/bin/xds-agent

On Windows, you can start-it manually using following commands:
C:\AGL\xds\xds-agent\xds-agent.exe

Version 6.0.0
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Installing AGL SDKs
To build your AGL services or AGL applications using XDS you must install a SDK matching the target/board you want to use.
A SDK is a package that includes all tools you need to cross-build and cross-debug your service/application.
You can generate AGL SDK for the board you want to use or you can download a pre-packaged AGL SDK.

Install a new SDK from command line
Used

sdks

command of

xds-cli

tool to managed SDKs.

# List all available SDKs
xds-cli sdks ls -a
List of available SDKs:
ID

NAME

STATUS

VERSION

ARCH

ec15afe0

AGL-release-eel-4.99.4-raspberrypi3

Not Installed

4.99.4

armv7vehf-neon-vfpv4

944d2d5a

AGL-snapshots-master-latest-intel-corei7-64

Not Installed

4.99.3+snapshot corei7-64

cf3a4365

AGL-release-dab-4.0.2-qemux86-64

Not Installed

4.0.2

corei7-64

d65fe750

AGL-release-eel-latest-qemux86-64

Not Installed

4.99.3

corei7-64

a0ae663d

poky-agl-corei7-64-3.99.1+snapshot

Installed

3.99.1+snapshot corei7-64

87f0400b

AGL-release-dab-3.99.3-m3ulcb-nogfx

Installed

3.99.3

aarch64

8c2f2841

AGL-release-dab-4.0.2-dragonboard-410c

Not Installed

4.0.2

aarch64

...
# Install a SDK (downloaded + install)
xds-cli sdks install d65fe750
Installation of 'AGL-release-eel-latest-qemux86-64' SDK successfully started.
Downloading poky-agl-glibc-x86_64-agl-demo-platform-crosssdk-corei7-64-toolchain-4.99.5.sh ...
--2018-01-02 11:22:23--

https://download.automotivelinux.org/AGL/release/eel/latest/qemux86-64/deploy/sdk/poky-agl-glib

c-x86_64-agl-demo-platform-crosssdk-corei7-64-toolchain-4.99.5.sh
Resolving download.automotivelinux.org (download.automotivelinux.org)... 199.19.213.77
Connecting to download.automotivelinux.org (download.automotivelinux.org)|199.19.213.77|:443... connected.
HTTP request sent, awaiting response... 200 OK
Length: 665996704 (635M) [application/x-sh]
Saving to: ‘/tmp/tmp.wuQzLdImCS/poky-agl-glibc-x86_64-agl-demo-platform-crosssdk-corei7-64-toolchain-4.99.5.sh’
0K .......... .......... .......... .......... ..........

0% 82,7K 2h11m

50K .......... .......... .......... .......... ..........

0% 89,1K 2h6m

100K .......... .......... .......... .......... ..........

0% 82,0K 2h8m

...
50300K .......... .......... .......... .......... .......... 99% 2,15M 0s
650350K .......... .......... .......... .......

100% 4,04M=10m35s

2018-01-02 12:17:06 (1024 KB/s) - ‘/tmp/tmp.CWyEj3z76Q/poky-agl-glibc-x86_64-agl-demo-platform-crosssdk-corei7-64-toolch
ain-4.99.5.sh’ saved [665996704/665996704]
Automotive Grade Linux SDK installer version 4.99.5
===================================================
You are about to install the SDK to "/xdt/sdk/poky-agl/4.99.5/corei7-64". Proceed[Y/n]? Y
Extracting SDK..........................................................................................................
..........done
Setting it up...done
SDK has been successfully set up and is ready to be used.
Each time you wish to use the SDK in a new shell session, you need to source the environment setup script e.g.
$ . /xdt/sdk/poky-agl/4.99.5/corei7-64/environment-setup-corei7-64-agl-linux
SDK ID d65fe750-d3a7-38f5-83d8-3d3806054f8d successfully installed.
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# Abort an installation that is in progress
xds-cli sdks abort -id d65fe750
# Install a SDK (using a local SDK package/file)
xds-cli sdks install --file $HOME/xds-workspace/sdks/poky-agl-glibc-x86_64-agl-demo-platform-crosssdk-corei7-64-toolchai
n-4.99.5.sh
# List installed SDKs
xds-cli sdks ls
List of installed SDKs:
ID

STATUS

VERSION ARCH

e45ac787 AGL-corei7-64-4.99.5+snapshot

NAME

Installed

4.99.5

x86_64

d65fe750 AGL-release-eel-latest-qemux86-64

Installed

4.99.3

corei7-64

Installation based on a local SDK package is only supported when SDK file package is located in

$HOME/xds-workspace/sdks

directory

Install a new SDK from XDS Dashboard
Open XDS-Dashboard in web-browser and select
Then switch to

SDKs MANAGEMENT

SDKs

entry in left side menu.

view :

Use filter boxes to find the SDK you want to install and then click on plus icon (Actions column) to start installation.
SDK download and installation process may take several minutes and output of installation script (output of

add

script mentioned

in above chapter).
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Note that you can abort installation by clicking on

X(cross) Development System

CANCEL

button.

More info
Please refer to xds-server chapter for more details about SDKs management.
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Create your first AGL application
Prerequisites
xds-agent
xds-server

is running locally on your machine (see previous chapter: Installing XDS client tools )
is running locally in a docker container or is accessible on your network (see previous chapter: Installing XDS

server)
one or more SDK have been installed (see previous chapter: Installing AGL SDKs)
XDS configuration is correct: in other words, connection is correctly established between

xds-agent

and

xds-server

and no

error message is displayed when you open XDS Dashboard in a web browser.

Links to subchapters :
Setup
Build using command line tool
Build using XDS Dashboard
Build using a source code editor / IDE
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Setup
Let's use helloworld-native-application project as example, so you need first to clone this project into a directory that will be
accessible by

xds-server

.

Depending of the project sharing method:
Cloud sync: you can clone project anywhere on your local disk,
Path mapping: you must clone project into

$HOME/xds-workspace

directory.

Note: : helloworld-native-application project is an AGL project based on app-templates (included as a git submodule). This CMake
templating, used to develop application with the AGL Application Framework, will automatically generate makefile rules (eg.
remote-target-populate

) or scripts (eg.

build/target/xxx

scripts).

For more info about app-template, please refer to this documentation.

Clone project
cd $HOME/xds-workspace
git clone --recursive https://github.com/iotbzh/helloworld-native-application.git
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Build using command line tool
Declare project
Use XDS command line tool named xds-cli to declare your project from command line and more precisely the
command (short option:

prj add

projects add

).

xds-cli prj add --label="Project_helloworld-native-application" --type=pm --path=/home/seb/xds-workspace/helloworld-nati
ve-application --server-path=/home/devel/xds-workspace/helloworld-native-application

Note: option

may be added to

--url=http://localhost:1234

xds-cli

in order to set url of

xds-agent

in case of

agent is not running on default port (for example here, 1234)

Build from command line
You need to determine which is the unique id of your project. You can find this ID in project page of XDS dashboard or you can get
it from command line using

xds-cli

tool and

projects list

command (short:

prj ls

):

xds-cli prj ls
ID

Label

LocalPath

f9904f70-d441-11e7-8c59-3c970e49ad9b

Project_helloworld-service

/home/seb/xds-workspace/helloworld-serv

Project_helloworld-native-application

/home/seb/xds-workspace/helloworld-nati

ice
4021617e-ced0-11e7-acd2-3c970e49ad9b
ve-application

XDS tools, including

xds-cli

are installed by default in

/opt/AGL/bin

directory and this path has been added into your PATH

variable.
If it is not the case, just add it manually using

export PATH=${PATH}:/opt/AGL/bin

Now to refer your project, just use --id option or use

XDS_PROJECT_ID

command line.

environment variable.

Note:
Short id notation is also supported as soon as given id value is non ambiguous.
For example, to refer to Project_helloworld-native-application project listed in above command, you can simply use --id 40 instead of
--id 4021617e-ced0-11e7-acd2-3c970e49ad9b
You also need to determine the ID of the cross SDK you want to use to cross build you application.
To list installed SDK, use the following command:
xds-cli sdks ls
List of installed SDKs:
ID

NAME

7aa19224-b769-3463-98b1-4c029d721766

aarch64

41a1efc4-8443-3fb0-afe5-8313e0c96efd

corei7-64

c226821b-b5c0-386d-94fe-19f807946d03

aarch64

(3.99.1+snapshot)
(3.99.2+snapshot)

(3.99.3)

You are now ready to use XDS to for example cross build your project.
Here is an example to build a project based on CMakefile:
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# Go into your project directory and create a build directory
cd $MY_PROJECT_DIR
mkdir build
# Generate build system using cmake
xds-cli exec --id=4021617e --sdkid=c226821b -- "cd build && cmake .."
# Build the project
xds-cli exec --id=4021617e --sdkid=c226821b -- "cd build && make all"

Note: If you use
build && make

,

&&

||

or

;

statement in the executed command line, you need to double quote the command, for example

"cd

.

To avoid to set project id, sdks id, url, ... for each command line, you can define these settings as environment variables within an
env file and just set

--config

option or source file before executing xds-cli command.

Note that XDS creates a file named
Dashboard (or using

xds-project.conf

xds-cli prj add...

(only if not already exists) when you declare a new project using XDS

). Edit this file if needed and then refer it with

--config

option.

For example, the equivalence of above command is:
# MY_PROJECT_DIR=/home/seb/xds-workspace/helloworld-native-application
cd $MY_PROJECT_DIR
# Edit and potentially adapt xds-project.conf file that has been created
# automatically on project declaration using XDS Dashboard
cat xds-project.conf
# XDS project settings
export XDS_AGENT_URL=localhost:8800
export XDS_PROJECT_ID=4021617e-ced0-11e7-acd2-3c970e49ad9b
export XDS_SDK_ID=c226821b-b5c0-386d-94fe-19f807946d03
# Create build directory and invoke cmake and then build project
xds-cli exec --config=./xds-project.conf -- "mkdir -p build && cd build && cmake .."
cd build && xds-cli exec --config=../xds-project.conf -- "make all"
# Or equivalent by first sourcing conf file (avoid to set --config option)
source xds-project.conf
xds-cli exec "mkdir -p build && cd build && cmake .."
cd build && xds-cli exec "make all"

Note: all parameters after a double dash (--) are considered as the command to execute.
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Build using XDS Dashboard
Declare project
Use XDS Dashboard to declare your project. Open a browser and connect to XDS Dashboard.
URL depends of your config, for example
Open the right sidebar and select

Version 6.0.0
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Sharing Type

and paths according to your needs.

Note that XDS creates (if not already exists) a file named

xds-project.conf

This file may be very useful when you plan to use XDS client tools such as

when you declare a new project.
xds-cli

or

xds-gdb

.

Note:
When

Path mapping

type is selected, you must clone your project into

$HOME/xds-workspace

directory (named Local Path in modal

window).
If XDS server is running in the XDS docker container (see Installation based on Docker container ), the Server Path must be set to
/home/devel/xds-workspace/xxx

If you select

Cloud Sync

where xxx is your project directory name.

, you can clone your project wherever you want on your local disk.

Build from XDS dashboard
Open the build page build entry of left sidebar

,

then select your Project and the Cross SDK you want to use and click on Clean / Pre-Build / Build / Populate buttons to execute
various build actions.
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Build using a source code editor / IDE
First create an XDS config file or reuse the previous one, for example we use here aarch64 SDK to cross build application for a
Renesas Gen3 board.
# create file at root directory of your project
# for example:
# MY_PROJECT_DIR=/home/seb/xds-workspace/helloworld-native-application
cat > $MY_PROJECT_DIR/xds-project.conf << EOF
export XDS_AGENT_URL=localhost:8800
export XDS_PROJECT_ID=4021617e-ced0-11e7-acd2-3c970e49ad9b
export XDS_SDK_ID=c226821b-b5c0-386d-94fe-19f807946d03
EOF

NetBeans
This chapter will show you how to create 2 configurations, one to compile your project natively (using native GNU gcc) and one to
cross-compile your project using XDS.
You can easily switch from one to other configuration using menu Run -> Set Project Configuration.
Netbeans 8.x :
Open menu Tools -> Options
Open C/C++ tab, in Build Tools sub-tab, click on Add button:

Then, you should set Make Command and Debugger Command to point to xds tools:
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Finally click on OK button.
Now create we first declare project into NetBeans and create first a native configuration. To do that, open menu File -> New
Project
Select C/C++ Project with Existing Sources ; Click on Next button
Specify your project directory and set Select Configuration Mode to Custom. Keep Tool Collection to Default GNU in
order to create a native configuration based on native GNU GCC. Finally click on Next button.
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build_native

suffix so that resulting build files will be located into

build_native

sub-directory. Keep all others settings to default value and click on Next button.

Click several times on Next button (always keep default settings) and click on Finish button to complete creation of native
configuration.
Now we will create a cross configuration based on XDS tools. Edit project properties (using menu File -> Project
Properties) to add a new configuration that will use XDS to cross-compile your application for example for a Renesas Gen3
board.
in Build category, click on Manage Configurations button and then New button to add a new configuration named for
example "Gen3 board"
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Click on Set Active button
Select Pre-Build sub-category, and set:
Working Directory:
Command Line:

build_gen3

xds-cli exec -c ../xds-project.conf -- cmake -DRSYNC_TARGET=root@renesas-gen3 -

DRSYNC_PREFIX=/opt ..

Pre-build First:

ticked

Select Make sub-category, and set:
Working Directory:

build_gen3

Build Command:

xds-cli exec -c ../xds-project.conf -- make remote-target-populate

Clean Command:

xds-cli exec -c ../xds-project.conf -- make clean

Select Run sub-category, and set:
Run Command:
Run Directory:
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Click on OK button to save settings
By changing configuration from Default to Gen3 board, you can now simply compile your helloworld application natively
(Default configuration) or cross-compile your application through XDS for the Renesas Gen3 board (Gen3 board configuration).

Visual Studio Code
Open your project in VS Code
cd $MY_PROJECT_DIR
code . &

Add new tasks : press

Ctrl+Shift+P

and select the

Tasks: Configure Task

command and you will see a list of task runner

templates.
And define your own tasks, here is an example to build helloworld-native-application AGL helloworld application based on cmake
template.
{
"version": "2.0.0",
"type": "shell",
"presentation": {
"reveal": "always"
},
"tasks": [
{
"label": "clean",
"type": "shell",
"command": "/bin/rm -rf ${workspaceFolder}/build/* && mkdir -p build && echo Cleanup done.",
"problemMatcher": []
},
{
"label": "pre-build",
"type": "shell",
"group": "build",
"command": "/opt/AGL/bin/xds-cli exec --rpath build --config xds-project.conf -- cmake -DRSYNC_TARGET=root@r
enesas-gen3 -DRSYNC_PREFIX=/opt ../",
"problemMatcher": [
"$gcc"
]
},
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{
"label": "build",
"type": "shell",
"group": "build",
"command": "/opt/AGL/bin/xds-cli exec --rpath build --config xds-project.conf -- make widget",
"problemMatcher": [
"$gcc"
]
},
{
"label": "populate",
"type": "shell",
"command": "/opt/AGL/bin/xds-cli exec --rpath build --config xds-project.conf -- make widget-target-install"
,
"problemMatcher": []
}
]
}

To run a task : press

Ctrl+Shift+P

, select the

Tasks: Run task

and then select for example

pre-build

to trigger pre-build task.

Note:
You can also add your own keybindings to trig above tasks, for example:
// Build
{
"key": "alt+f9",
"command": "workbench.action.tasks.runTask",
"args": "clean"
},
{
"key": "alt+f10",
"command": "workbench.action.tasks.runTask",
"args": "pre-build"
},
{
"key": "alt+f11",
"command": "workbench.action.tasks.runTask",
"args": "build"
},
{
"key": "alt+f12",
"command": "workbench.action.tasks.runTask",
"args": "populate"
},

More details about VSC keybindings here
More details about VSC tasks here

Qt Creator
Please refer to agl-hello-qml project. Thanks to Dennis for providing this useful example.

Others IDE
Coming soon...
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Debug your first AGL application
Debug is based on gdb and you need to use

xds-gdb

as a wrapper on gdb to cross-debug your application.

This tool allows you to debug an application built with XDS without the need to install gdb or any cross tools.
Two debugging models are supported:
1. native debugging
2. XDS remote debugging requiring an XDS agent/server setup and that allows you to cross debug your application.
By default XDS debug model is used and you need to define

XDS_NATIVE_GDB

variable to use native gdb debug mode instead.

Links to subchapters :
Configuration
xds-gdb from command line
xds-gdb within an IDE
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Configuration
xds-gdb

configuration is defined by variables (see listed below). These variables may be set using :

environment variables (inherited),
or a config file set with

XDS_CONFIG

environment variable, for example:

XDS_CONFIG=/tmp/my_xds_gdb_config.env xds-gdb

or by setting variables within a gdb ini file (see details below),
or a "user" config file located in following directory (first found is taken):
1. $(CURRENT_DIRECTORY)/.xds-gdb.env
2. $(CURRENT_DIRECTORY)/../xds-gdb.env
3. $(CURRENT_DIRECTORY)/target/xds-gdb.env
4. $(HOME)/.config/xds/xds-gdb.env

Configuration Variables
XDS_CONFIG

Config file defining

configuration variables.

XDS_xxx

Variables of this file will overwrite inherited environment variables.
Variables definition may be prefixed or not by "export" keyword.
Here is an example of configuration file:
# for example:
# MY_PROJECT_DIR=/home/seb/xds-workspace/helloworld-native-application
cat > $MY_PROJECT_DIR/xds-gen3.conf << EOF
export XDS_AGENT_URL=localhost:8800
export XDS_PROJECT_ID=4021617e-ced0-11e7-acd2-3c970e49ad9b
export XDS_SDK_ID=c226821b-b5c0-386d-94fe-19f807946d03
EOF

XDS_LOGLEVEL

Set logging level (supported levels: panic, fatal, error, warn, info, debug)
XDS_LOGFILE

Set logging file, default

/tmp/xds-gdb.log

.

XDS_NATIVE_GDB

Use native gdb mode instead of remote XDS mode.
XDS_PROJECT_ID

(mandatory in XDS mode)

Project ID you want to build
XDS_RPATH

Relative path into project
XDS_SDK_ID

(mandatory in XDS mode)

Cross Sdk ID to use to build project
XDS_AGENT_URL

Local XDS agent url (default

http://localhost:8800

)

Configuration variables set within gdb init command file
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Configuration variables set within gdb init command file
Above

XDS_xxx

variables may also be defined within gdb init command file (see --command or -x option of genuine Gdb).

You must respect the following syntax: commented line including

:XDS-ENV:

tag

Example of gdb init file where we define project and sdk ID:
# :XDS-ENV: XDS_PROJECT_ID=4021617e-ced0-11e7-acd2-3c970e49ad9b
# :XDS-ENV: XDS_SDK_ID=c226821b-b5c0-386d-94fe-19f807946d03
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Debug using xds-gdb from command line
XDS remote debugging mode
First the project you want to debug must be declared on an xds-server and this project may also has been built using using XDS (see
Create your first AGL application for more details).
So to debug it you need to have the XDS agent - server chain in place and you also need the project and sdk unique id.
You can find these IDs in project page of XDS dashboard or you can get them from command line using the

--list

option.

This option lists all existing projects ID:
xds-gdb --list

Now to refer your project, just set
You are now ready to use

xds-gdb

XDS_PROJECT_ID

and

XDS_SDK_ID

variables.

to for example cross debug your project.

Here is an example to build and debug a project based on CMakefile and AGL app-templates:
# Go into your project directory (for example helloworld-native-application)
cd ~/xds-workspace
git clone https://github.com/iotbzh/helloworld-native-application.git
cd helloworld-service
# Declare your project on xds-server
# <for now, you can only do this step using xds HTML dashboard (see xds-server doc)>
# Define XDS config
cat <<EOF >./xds-config.env
#optional if not default value: XDS_AGENT_URL=http://localhost:8800
XDS_PROJECT_ID=IW7B4EE-DBY4Z74_myProject
XDS_SDK_ID=poky-agl_aarch64_4.0.1
EOF
# Tell to xds-cli and xds-gdb which is your config file
export XDS_CONFIG=../xds-gen3.conf
# Create a new build directory
mkdir build && cd build
# Start remote cross build
xds-cli exec -- cmake -DRSYNC_TARGET=root@myTarget ..
xds-cli exec -- make
xds-cli exec -- make remote-target-populate
# Start debugging
xds-gdb -x target/gdb-on-root@myTarget.ini

Note: : helloworld-native-application project is an AGL project based on app-templates (included as a git submodule). This CMake
templating, used to develop application with the AGL Application Framework, will automatically generate makefile rules (eg.
remote-target-populate

) or scripts (eg.

build/target/xxx

scripts).

For more info about app-template, please refer to this documentation.

Native debugging
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Debug using xds-gdb within an IDE
First the project you want to debug must be declared on an xds-server and this project may also has been built using using XDS (see
Create your first AGL application for more details).

Netbeans
Netbeans 8.x :
Open menu Tools -> Options
Open C/C++ tab, in Build Tools sub-tab, click on Add button:

Then, you should set Make Command and Debugger Command to point to xds tools:
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Finally click on OK button.
Edit project properties (using menu File -> Project Properties) to update Debug settings:
Be sure that "Gen3 board" configuration is selected
Select Run category, and set:
Run Command:

target/start-on-root@renesas-gen3.sh

(script name may depend of RSYNC_TARGET variable you

set in pre-build command)
Run Directory:

build_gen3

Select Debug category, and set:
Debug command:

/bin/true

Working Directory: empty field
Gdb Init File:

target/gdb-on-root@renesas-gen3.ini

(script name may depend of RSYNC_TARGET variable you set

in pre-build command)

Version 6.0.0

October 2018

40

IoT.Bzh

X(cross) Development System

Click on Apply and then OK button to save settings
You can now start debugging your application with menu Debug -> Debug Project (or CTRL+F5 shortcut)

Others IDE
Coming soon...
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XDS internals (advanced documentation)
Abstract
This 2nd part is the "technical" documentation of all XDS pieces/tools that allows for example to fine tune XDS configuration or
rebuild all XDS tools from scratch.
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Prerequisites
XDS is written in Go and currently only build on Linux host has been validated.
So to build XDS binaries you need to install first Go version 1.8.1 or higher and some other tools. To build
agent

you also need to install in addition

nodejs

and

python3

xds-server

and

xds-

tools.

Ubuntu:
# Install various tools
sudo apt-get install git make npm curl git zip unzip wget
# Install Go
source /etc/os-release
wget -O - "http://keyserver.ubuntu.com/pks/lookup?op=get&search=0x52B59B1571A79DBC054901C0F6BC817356A3D45E" | sudo apt-k
ey add sudo bash -c "cat >> /etc/apt/sources.list.d/golang.list <<EOF
deb http://ppa.launchpad.net/longsleep/golang-backports/ubuntu ${VERSION_CODENAME} main
EOF"
sudo apt-get update
sudo apt-get install golang-go
# Install python3
sudo apt-get install python3

openSUSE:
# Install various tools
sudo zypper install git make npm curl zip unzip
# Install Go
# ( the value 'DISTRO' can be set to {openSUSE_Leap_42.2, openSUSE_Leap_42.3, openSUSE_Tumbleweed} )
source /etc/os-release; export DISTRO="openSUSE_Leap_$VERSION"
sudo zypper ar http://download.opensuse.org/repositories/devel:/languages:/go/${DISTRO}/devel:languages:go.repo
sudo zypper --gpg-auto-import-keys ref
sudo zypper install go1.9
# Install python3
sudo zypper install python3

Don't forget to open new user session after installing these packages.
All Linux distro:
# Install nodejs LTS version (only mandatory for xds-server and xds-agent)
sudo npm install --global n
sudo n lts

Angular developers that's plan to modify XDS Dashboard webapp (part of
ng

xds-agent

repo) may also need angular cli tool named

:

# Install angular cli tool (ng)
sudo npm install --global n @angular/cli
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XDS - X(cross) Development System Server
xds-server

is a web server that allows user to remotely cross build applications.

The first goal is to provide a multi-platform cross development tool with near-zero installation.
The second goal is to keep application sources locally (on user's machine).
Make it compatible with existing IT policies (e.g. corporate backup or SCM).
Let user to continue to work as usual.
Use his favorite editor.
keep performance while editing/browsing sources.
Avoids manual operation
This powerful and portable webserver (written in Go) exposes a REST interface over HTTP.
xds-server
xds-server

uses Syncthing tool to synchronize projects files from user machine to build server machine or container.
is commonly running on a build server (within a container or not) and xds-agent must run on the developer/user

machine in order to setup the following connection chain:
developer/user machine

|

build server or container

---------------------------|----------------------------xds-cli <---> xds-agent <-|-> xds-server

SEE ALSO: xds-cli, a command-line tool that allows you to send commands to

xds-agent / xds-server

and for example build

your application from command-line or from your favorite IDE (such as Netbeans or Visual Studio Code) through
xds-server

xds-agent <=>

.

Links to subchapters :
Configuration
How to run
Build from scratch
Debugging
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Configuration
xds-server

configuration is driven by a JSON config file (

Here is the logic to determine which
1. from command line option:

server-config.json

server-config.json

).

file will be used:

--config myConfig.json

2.

$HOME/.xds/server/server-config.json

file

3.

/etc/xds/server/server-config.json

4.

<xds-server executable dir>/server-config.json

file
file

Supported fields in configuration file are:
httpPort : HTTP port of client webapp/REST API
webAppDir : location of client web application (default: webapp/dist)
shareRootDir : root directory where projects will be copied
logsDir : directory to store logs (eg. syncthing output)
sdkScriptsDir : directory where scripts, used to managed SDKs, are installed
sdkDbUpdate : define how SDK database(s) is(are) updated, supported values are:

disable

,

startup

(default:

startup

)

syncthing.binDir : syncthing binaries directory (default: executable directory)
syncthing.home" : syncthing home directory (usually .../syncthing-config)
syncthing.gui-address : syncthing gui url (default http://localhost:8385)
syncthing.gui-apikey : syncthing api-key to use (default auto-generated)
All fields are optional and example below corresponds to the default values.
{
"httpPort": 8000,
"webAppDir": "webapp/dist",
"shareRootDir": "${HOME}/.xds/server/projects",
"logsDir": "/tmp/logs",
"sdkScriptsDir": "${EXEPATH}/scripts/sdks",
"sdkDbUpdate": "startup",
"syncthing": {
"binDir": "./bin",
"home": "${HOME}/.xds/server/syncthing-config",
"gui-address": "http://localhost:8385",
"gui-apikey": "123456789",
}
}

Notes:
Environment variables are supported by using
When

xds-server

xds-server

syntax.

is started as a systemd service, default environment variables are set into

configuration is also driven by a JSON config file (

/etc/xds/server/server-config.json

/etc/default/xds-server

server-config.json

file.

), and default JSON config is

.

Note: You can use your own JSON config by settings
example

${MY_VAR}

APP_CONFIG

variable of

/etc/default/xds-server

file to your file, for

/home/MYUSER/.xds/server/server-config.json

Disable syncthing
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synchronization type based on

syncthing

tool can be disabled by simply removing (or renaming)

key in

"syncthing"

configuration file. Here is a JSON configuration file example where syncthing key as been renamed:
{
"httpPort": 8000,
"webAppDir": "webapp/dist",
"shareRootDir": "${HOME}/.xds/server/projects",
"logsDir": "/tmp/logs",
"sdkScriptsDir": "${EXEPATH}/scripts/sdks",
"syncthing_DISABLE": {
"binDir": "./bin",
"home": "${HOME}/.xds/server/syncthing-config",
}
}

On benefit to do that is to increase XDS-Server startup time.
Note:
CloudSync

(AKA syncthing) synchronization type can also be disabled when

"syncthing"

key is not defined in JSON

configuration file.
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How to run
xds-server

has been designed to easily compile and debug AGL applications. That's why

xds-server

has been integrated into

AGL SDK docker container.
Note: For more info about AGL SDK docker container, please refer to AGL SDK Quick Setup

Start xds-server
There are several way to install xds-server and start-up depend of installation type:
Installation
type

Supported
host OS

Start-up

Install instructions

Docker
container

Linux or MacOS

Automatic based on systemd user
service

see Installation based on Docker
container

Virtual
Machine

Linux, MacOS or
Windows

Automatic based on systemd user
service

see Installation based on
VirtualBox appliance

Native

Linux

Automatic based on systemd user
service or manual

see Native installation

Native

MacOS or Windows

Manually

see Native installation

Automatic start-up based on systemd user service
XDS server is started as a user service by Systemd.
/usr/lib/systemd/user/xds-server.service

Use well-known systemd commands to control

xds-server.service

service.

# Enter in docker container or VM
# (optional, depending on installation type)
ssh -p 2222 devel@localhost
# Status XDS server:
systemctl --user status xds-server
# Restart XDS server
systemctl --user restart xds-server

If needed you can change default setting by defining specific environment variables file
ssh -t -p 2222 devel@localhost vim /etc/default/xds-server

For example to control log level, just set LOG_LEVEL env variable.
knowing that supported level are:
panic
fatal
error
warn
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info
debug
docker exec ${CONTAINER_NAME} bash -c "echo 'LOG_LEVEL=debug' >> /etc/default/xds-server"
ssh -p 2222 devel@localhost -- "systemctl --user restart xds-server"

Manual start-up
On Linux or MacOS, simply execute

xds-server

executable:

/opt/AGL/bin/xds-server

On Windows, simply execute

xds-server

executable:

C:\AGL\bin\xds-server.exe

Note:
Invoke

xds-server --help

to get more details about possible options that allow for example to change logging level or select

another configuration file.

XDS server REST API and Web application
xds-server

exposes a REST API and serves a basic web-application.

REST API based url is

http://localhost:8000/api/v1/

when XDS server is running on your host (localhost) and basic web-

application is available at http://localhost:8000.
Just replace

localhost

by the host name or ip when

xds-server

is running on another host.

# Get version using REST API
curl http://localhost:8000/api/v1/version
# Open browser and local xds-server web-application
xdg-open http://localhost:8000

Then follow instructions provided on this page to install and start

xds-agent

that must run locally on your machine.

See also xds-agent documentation for more details.

SDK cross-toolchain Management
Setup to add support of a new SDK family
Optional step: read this chapter only if you plan to add a new SDK family.
xds-server

dynamically detects supported SDKs by scanning sub-directories of

sdkScriptsDir

directory (see Configuration

chapter).
Each sub-directory (usually name is the same as the SDK family) of
by

xds-server

sdkScriptsDir

must contain a set of scripts that will be called

to managed SDKs of a specific family.

These scripts are:
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: used to add/install a new SDK

db-dump

: returned the list of available and installed SDKs (JSON format)
: update SDKs database

db-update

: returned SDK family configuration structure (JSON format)

get-family-config

: extract SDK info (JSON format) from a SDK file/tarball

get-sdk-info

: used to remove an existing SDK

remove

For example, here 2 SDKs family (

agl

and

zephyr

) are defined:

# > tree ./sdks/
./sdks/
├── agl
│

├── add

│

├── db-dump

│

├── db-update

│

├── get-family-config

│

├── get-sdk-info

│

└── remove

├── README.md
└── zephyr
├── add
│

├── db-dump

│

├── db-update

│

├── get-family-config

│

├── get-sdk-info
└── remove

On startup

xds-server

will call in order:

sdks/*/get-family-config
sdks/*/db-update
sdks/*/db-dump

Please refer to

to get configuration of each SDK family.

to update database (only when

SdkDbUpdate

is set to ̀

startup

, see Configuration chapter for more details)

scripts to get the initial list of available and installed SDKs.

sdks/README.md

for more information about scripts definition and to understand how to add support of a new SDK

family.

Install a new SDK
Please refer to Installing AGL SDKs chapter.

Un-install a SDK from command line
Used

sdks

command of

xds-cli

tool to managed SDKs.

# List installed SDKs
xds-cli sdks ls
List of installed SDKs:
ID

NAME

STATUS

VERSION

ARCH

c39e5998

poky-agl_aarch64_4.0.1

Installed

4.0.1

aarch64

d610bfbf

poky-agl-aarch64.current_on_iotbzh_download-3.99.1+snapshot

Installed

3.99.1+snapshot aarch64.

current_on_iotbzh_download
a0ae663d

poky-agl-corei7-64-3.99.1+snapshot

Installed

3.99.1+snapshot corei7-6

87f0400b

AGL-release-dab-3.99.3-m3ulcb-nogfx

Installed

3.99.3

352c0584

poky-agl-corei7-64-3.99.2+snapshot

Installed

3.99.2+snapshot corei7-6

d65fe750

AGL-release-eel-latest-qemux86-64

Installed

4.99.5

4
aarch64

4
corei7-6

4
# Un-install a SDK
xds-cli sdks uninstall d65fe750
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SDK ID d65fe750-d3a7-38f5-83d8-3d3806054f8d successfully deleted.

Un-install a SDK from XDS Dashboard
Open XDS-Dashboard in web-browser and select
If needed, switch to

Version 6.0.0
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entry in left side menu.
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Build xds-server from scratch
Dependencies
Install Go, npm, nodejs and some other tools.
Refer to Prerequisites chapter for more details.

Building
Native build
Clone sources under

$ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds/xds-server

in order respect directory hierarchy that

match Go package import logic (see How to Write Go Code for more details).
Then use delivered Makefile :
# Declare ROOTDIR, can be any location (for example xds-build)
ROOTDIR=$HOME/xds-build
# Create directory hierarchy that match Go package import logic
mkdir -p $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
cd $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
# Clone sources
git clone https://gerrit.automotivelinux.org/gerrit/src/xds/xds-server
# or git clone ssh://YOUR_USERNAME@gerrit.automotivelinux.org:29418/src/xds/xds-server
# Build xds-server
# (note that GOPATH will correctly be set by Makefile)
cd xds-server
make all

Generate xds-server package / tarball
make package-all

And to install

xds-server

(by default in

/opt/AGL/xds/server

):

make install

Warning:
Makefile install rule and default values in configuration file are set to fit the docker setup.
So you may need to adapt some settings when you want to install xds-server natively.
Note:
Used

DESTDIR

to specify another install directory

make install DESTDIR=$HOME/opt/xds-server

XDS docker image
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XDS docker image
As an alternative to a pre-build image, you can rebuild the container from scratch.
xds-server

has been integrated as a flavour of AGL SDK docker image.

So to rebuild docker image just execute following commands:
# Clone docker-worker-generator git repo
git clone https://git.automotivelinux.org/AGL/docker-worker-generator
# Start build that will create a docker image
cd docker-worker-generator
make build FLAVOUR=xds
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Debugging
XDS server architecture
The server part is written in Go and web app (basic HTML) in Angular4.
|
+-- bin/

# where xds-server binary file will be built

|
+-- conf.d/

# Linux configuration and startup files (systemd user service)

|
+-- glide.yaml

# Go package dependency file

|
+-- lib/

# sources of server part (Go)

|
+-- LICENSE

# XDS server license

|
+-- main.go

# main entry point of of Web server (Go)

|
+-- Makefile

# makefile including

|
+-- README.md

# readme

|
+-- scripts/

# hold various scripts used for installation or startup

|
+-- test/

# XDS test suite

|
+-- tools/

# temporary directory to hold development tools (like glide)

|
+-- vendor/

# temporary directory to hold Go dependencies packages

|
+-- webapp/

# source client basic web application

Debug server part (Go code)
Install first Visual Studio Code and Go plugin (

ext install lukehoban.Go

Visual Studio Code launcher settings can be found into

)

.vscode/launch.json

.

Please follow instructions of xds-agent debugging chapter, knowing that you execute these same instructions in

xds-server

repo, in

other words by replacing xds-agent references by xds-server.
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XDS Server Test
XDS Server test architecture
The test part is written in go and source code is available in test directory.
|
+-- test/

# where xds-server test source files

|
+-- test/main_test.go

# main entry point of xds-server test

|
+-- test/fixtures

# fixtures for running test

The test execution will locally launch xds-server and access the api through REST and test results, events, ...

Dependencies
sshd
Make sure sshd is in your user PATH.

Launch test
Use the following command to launch test in xds-server root directory:
make test

Launch only one test, for example launch TestSdks:
make test name=TestSdks

Increase test verbosity:
make test VERBOSE=1
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XDS - X(cross) Development System Agent
XDS-agent is a client that should run on your local / user development machine when you use XDS.
This agent takes care, among others, of starting Syncthing tool to synchronize your project files from your local host to XDS build
server machine or container (where

xds-server

is running).

SEE ALSO: xds-server, a web server used to remotely cross build applications.

Links to subchapters :
Configuration
Start-up
Build from scratch
Debugging
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Configuration
xds-agent configuration is driven by a JSON config file.
The tarball mentioned in previous section includes this file with default settings.
Here is the logic to determine which conf file will be used:
1. from command line option:

--config myConfig.json

2.

$HOME/.xds/agent/agent-config.json

3.

/etc/xds/agent/agent-config.json

file

file

Supported fields in configuration file are (all fields are optional and example below corresponds to the default values):
httpPort : http port of agent REST interface
webAppDir : location of client webapp / dashboard (default: webapp/dist)
logsDir : directory to store logs (eg. syncthing output)
xdsServers : an array of xds-server object
xdsServers.url: url of xds-server to connect to
syncthing: a object defining syncthing settings
syncthing.binDir : syncthing binaries directory (default: executable directory)
syncthing.home" : syncthing home directory (usually .../syncthing-config)
syncthing.gui-address : syncthing gui url (default http://localhost:8386)
syncthing.gui-apikey : syncthing api-key to use (default auto-generated)
{
"httpPort": "8800",
"webAppDir": "./www",
"logsDir": "${HOME}/.xds/agent/logs",
"xdsServers": [
{
"url": "http://localhost:8000"
}
],
"syncthing": {
"home": "${HOME}/.xds/agent/syncthing-config",
"gui-address": "http://localhost:8386",
"gui-apikey": "1234abcezam"
}
}

Note:
environment variables are supported by using
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Start-up
Start-up based on systemd user service
For Linux distro, XDS agent can be started as a user service by Systemd.
/usr/lib/systemd/user/xds-agent.service

Use well-known systemd commands to control

xds-agent.service

service.

# Status XDS agent:
systemctl --user status xds-agent
# Start XDS agent
systemctl --user start xds-agent
# Stop XDS agent
systemctl --user stop xds-agent

Default settings are defined in
config.json

/etc/default/xds-agent

file but these settings you can overwritten by

$HOME/.xds/agent/agent-

file, see Configuration chapter for more details.

Manual start-up
On Linux or MacOS, simply execute

xds-agent

executable:

/opt/AGL/bin/xds-agent

On Windows, simply execute

xds-agent

executable (root path may change depending where you installed/unzipped xds-agent

tarball):
C:\AGL\bin\xds-agent.exe

Note:
If need be, you can increase log level by setting option
Invoke

xds-agent --help

--log <level>

, supported level are: panic, fatal, error, warn, info, debug.

to get more details about possible options that allow for example to change logging level or select a

specific configuration file.
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Build xds-agent from scratch
Dependencies
Install Go, npm, nodejs and some other tools.
Refer to Prerequisites chapter for more details.

Building
Clone sources under

$ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds/xds-agent

in order respect directory hierarchy that

match Go package import logic (see How to Write Go Code for more details).
Then use delivered Makefile :
# Declare ROOTDIR, can be any location (for example xds-build)
ROOTDIR=$HOME/xds-build
# Create directory hierarchy that match Go package import logic
mkdir -p $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
cd $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
# Clone sources
git clone https://gerrit.automotivelinux.org/gerrit/src/xds/xds-agent
# or git clone ssh://YOUR_USERNAME@gerrit.automotivelinux.org:29418/src/xds/xds-agent
# Build xds-agent
# (note that GOPATH will correctly be set by Makefile)
cd xds-agent
make all

Generate xds-agent packages / tarballs for Linux, MacOS, Windows
make package-all

And to install

xds-agent

(by default in

/opt/AGL/xds/agent

):

make install

Warning:
Makefile install rule and default values in configuration file are set to fit the docker setup.
So you may need to adapt some settings when you want to install xds-agent natively.
Note:
Used

DESTDIR

to specify another install directory

make install DESTDIR=$HOME/opt/xds-agent

Cross build
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For example on a Linux machine to cross-build for Windows, just follow these steps.
The first time you need to install all the windows-amd64 standard packages on your system with
# List all supported OS / ARCH
go tool dist list
# Install all standard packages for another OS/ARCH (eg. windows amd64)
GOOS=windows GOARCH=amd64 go install -v -a std

Then compile and package xds-agent using provided makefile
export GOOS=windows
export GOARCH=amd64
make all
make package
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Debugging
XDS agent architecture
The agent part is written in Go and the webapp / dashboard is in typescript + Angular4.
|
+-- bin/

where xds-server binary file will be built

|
+-- conf.d

Linux configuration and startup files (systemd user service)

|
+-- glide.yaml

Go package dependency file

|
+-- lib/

sources of server part (Go)

|
+-- main.go

main entry point of of Web server (Go)

|
+-- Makefile

makefile including

|
+-- README.md

readme

|
+-- scripts/

hold various scripts used for installation or startup

|
+-- tools/

temporary directory to hold development tools (like glide)

|
+-- vendor/

temporary directory to hold Go dependencies packages

|
+-- webapp/

source client basic webapp / dashboard

Debug xds-agent (Go code)
Install first Visual Studio Code and Go plugin (

ext install lukehoban.Go

Visual Studio Code launcher settings can be found into

)

.vscode/launch.json

. The important think is to correctly set

GOPATH

launch.json in order to build xds-agent and debug it within Visual Studio Code.
Here is an example of launch.json:
{
"version": "0.2.0",
"configurations": [{
"name": "XDS-Agent",
"type": "go",
"request": "launch",
"mode": "debug",
"remotePath": "",
"port": 2345,
"host": "127.0.0.1",
"program": "${workspaceRoot}",
"env": {
"GOPATH": "${workspaceRoot}/../../../../../..:${env:GOPATH}",
},
"args": ["-log", "debug", "-c", "__agent-config_local_dev.json"],
"showLog": false
}
]
}
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__agent-config_local_dev.json

file content is as follow :

{
"webAppDir": "./webapp/dist",
"logsDir": "${HOME}/tmp/xds-agent/logs",
"xdsServers": [
{
"url": "http://localhost:8000"
}
],
"syncthing": {
"binDir": "./bin",
"home": "${HOME}/tmp/xds_local_dev/syncthing-config",
"gui-address": "http://localhost:8386",
}
}

Tricks to debug both xds-agent and xds-server
To debug both

and

xds-agent

A trick to do that is to replace
So clone first

xds-server

+

xds-server
xds-server

xds-common

+

or common code
xds-common

sources next to

in

xds-common
vendor

xds-agent

, it may be useful use the same local sources.

directory by a symlink that points to local sources.
directory.

You should have the following tree:
tree -L 5 src/
src/
`-- gerrit.automotivelinux.org
`-- gerrit
`-- src
`-- xds
|-- xds-agent
|-- xds-common
`-- xds-server

Then invoke

vendor/debug

Makefile rule to create symbolic links inside vendor directory :

cd src/gerrit.automotivelinux.org/gerrit/src/xds/xds-agent
make vendor/debug

Debug dashboard part (Typescript / angular code)
Start

xds-agent

either from command line or in debug mode (see previous chapter) and in another terminal start a watcher daemon

so that type typescript sources of webapp / dashboard are automatically "transpiled" using following command :
cd webapp
npm run watch

Then open the XDS Dashboard page (http://localhost:8800) and open the developer tool of web browser (for example
Ctrl+Shift+I

in Chrome).
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xds-cli: command-line tool for XDS
xds-cli

is a command-line tool for X(cross) Development System.

This tool can be used in addition to

XDS Dashboard

to control XDS from command line.

Links to subchapters :
Configuration
Start-up
Build from scratch
Debugging
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Configuration
xds-cli

configuration is defined either by environment variables or by setting command line options.

Configuration through environment variables may also be defined in a file that will be sourced by
Use

option or set

--config|-c

XDS_CONFIG

xds-cli

on start-up.

environment variable to specify the config file to use.

So configuration is driven either by environment variables or by command line options or using a config file knowing that the
following priority order is used:
1. use option value (for example use project ID set by
2. else use variable
3. else use

XDS_xxx

(for example

(for example

XDS_xxx

--id

XDS_PROJECT_ID

XDS_PROJECT_ID

option),
variable) when a config file is specified with

--config|-c

option,

) environment variable

Note:
All parameters after a double dash (--) are considered as the command to execute on xds-server.

Global Options / Configuration variables
Following is the list of global options across all sub-commands.
--config|-c

option or

XDS_CONFIG

env variable

Env config file to source on startup
option or

--log|-l

XDS_LOGLEVEL

env variable

Logging level, supported levels are:
panic
fatal
error
warn
info
debug
Default level is "error".
--rpath

option or

XDS_PATH

env variable

Relative path into project
timestamp|-ts

option or

XDS_TIMESTAMP

env variable

Prefix output with timestamp
url

option or

XDS_AGENT_URL

env variable

Local XDS agent url (default: "localhost:8800")
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Commands
projects
projects

(short

prj

) command should be used to managed XDS projects.

This command supports following sub-commands:
add, a

Add a new project

get

Get a property of a project

list, ls

List existing projects

remove, rm

Remove an existing project

sync

Force synchronization of project sources

Here are some usage examples:
# Create/declare a new project
xds-cli prj add --label "myProjectName" --type pm -p /home/seb/xds-workspace/myProject -sp /home/devel/xds-workspace/myP
roject
# List projects
xds-cli prj ls
# Delete an existing project
xds-cli prj rm 8e49

sdks
sdks

(alias

sdk

) command should be used to managed cross SDKs.

This command supports following sub-commands:
get

Get a property of a SDK

list, ls

List installed SDKs

install, i

Install a SDK

uninstall, rm

UnInstall an existing SDK

abort, a

Abort an install action

Here are some usage examples:
# List existing SDKs
xds-cli sdks ls
# Get SDK info
xds-cli sdks get c64d

Note:
Please also refer to Installing AGL SDKs chapter for more details about sdks installation.

exec
exec

command should be used to exec command through XDS system.
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For example you can use this command to build your project in XDS system.
This command supports following sub-commands:
exec

command options are:

--id

option or

XDS_PROJECT_ID

env variable (mandatory option)

project ID you want to build
--rpath

(short

-p

) or

XDS_RPATH

env variable

relative path into project
--sdkid

(alias

--sdk

) or

XDS_SDK_ID

env variable (mandatory option)

Cross Sdk ID to use to build project.
Here are some usage examples:
cd $MY_PROJECT_DIR
mkdir build
# Generate build system using cmake
xds-cli exec --id=4021 --sdkid=c226 -- "cd build && cmake .."
# Build the project
xds-cli exec --id=4021 --sdkid=c226 -- "cd build && make all"

In case of

xds-agent

is not running on default url:port (that is

You can specify the url using

--url

localhost:8800

)

option :

xds-cli --url=http://localhost:8800 exec --id=4021 --sdkid=c226 -- "cd build && make all"

misc
misc

command allows to execute miscellaneous sub-commands such as:

version, v

Get version of XDS agent and XDS server

status, sts

Get XDS configuration status (including XDS server connection)

Here are some usage examples:
xds-cli misc version --verbose
xds-cli misc sts
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How to build
Dependencies
Install Go and some other tools.
Refer to Prerequisites chapter for more details.

Building
Clone sources under

$ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds/xds-cli

in order respect directory hierarchy that

match Go package import logic (see How to Write Go Code for more details).
Then use delivered Makefile :
# Declare ROOTDIR, can be any location (for example xds-build)
ROOTDIR=$HOME/xds-build
# Create directory hierarchy that match Go package import logic
mkdir -p $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
cd $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
# Clone sources
git clone https://gerrit.automotivelinux.org/gerrit/src/xds/xds-cli
# or git clone ssh://YOUR_USERNAME@gerrit.automotivelinux.org:29418/src/xds/xds-cli
# Build xds-cli
# (note that GOPATH will correctly be set by Makefile)
cd xds-cli
make all

Generate xds-cli package / tarball
make package-all
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Debugging
XDS cli architecture
This tool is written in Go.
|
+-- bin/

# where xds-cli binary will be built

|
+-- cmd-XXX.go

# GO sources of each sub-commands

|
+-- conf.d/

# Linux configuration and startup files (systemd user service)

|
+-- glide.yaml

# Go package dependency file

|
+-- LICENSE

# XDS cli license

|
+-- main.go

# main entry point (Go)

|
+-- Makefile

# makefile including

|
+-- README.md

# readme

|
+-- scripts/

# hold various scripts used for installation

|
+-- vendor/

# temporary directory to hold Go dependencies packages

Debug
Install first Visual Studio Code and Go plugin (

ext install lukehoban.Go

Visual Studio Code launcher settings can be found into

)

.vscode/launch.json

.

Please follow instructions of xds-agent debugging chapter, knowing that you execute these same instructions in

xds-cli

repo, in

other words by replacing xds-agent references by xds-cli.
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xds-gdb: wrapper on gdb for XDS
xds-gdb

is a wrapper on gdb debugger for X(cross) Development System.

This tool allows you to debug an application built with an xds-server without the need to install gdb or any cross tool.
Two debugging models are supported:
1. native debugging
2. XDS remote debugging requiring an XDS agent/server setup. That allows you to easily cross debug your application.
By default XDS debug model is used and you need to define

XDS_NATIVE_GDB

variable to use native gdb debug mode instead.

Links to subchapters :
Configuration
Build from scratch
Debugging
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Configuration
xds-gdb

configuration is defined by variables (see listed below).

These variables may be set using:
environment variables (inherited),
or a config file set with

XDS_CONFIG

environment variable, for example:

XDS_CONFIG=/tmp/my_xds_gdb_config.env xds-gdb

or by setting variables within a gdb ini file (see details below),
or a "user" config file located in following directory (first found is taken):
1. $(CURRENT_DIRECTORY)/.xds-gdb.env
2. $(CURRENT_DIRECTORY)/../xds-gdb.env
3. $(CURRENT_DIRECTORY)/target/xds-gdb.env
4. $(HOME)/.config/xds/xds-gdb.env

Configuration Variables
XDS_CONFIG

Config file defining

XDS_xxx

configuration variables.

Variables of this file will overwrite inherited environment variables.
Variables definition may be prefixed or not by "export" keyword.
Here is an example of config file:
cat $HOME/myProject/xds-gdb.env
export XDS_AGENT_URL=http://localhost:8800
export XDS_PROJECT_ID=4021617e-ced0-11e7-acd2-3c970e49ad9b
export XDS_SDK_ID=c226821b-b5c0-386d-94fe-19f807946d03

XDS_LOGLEVEL

Set logging level
Supported levels:
panic
fatal
error
warn
info
debug
XDS_LOGFILE

Set logging file, default

/tmp/xds-gdb.log

.

XDS_NATIVE_GDB

Use native gdb mode instead of XDS mode.
XDS_PROJECT_ID

(mandatory in XDS mode)

Project ID you want to build
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XDS_RPATH

Relative path into project
XDS_SDK_ID

(mandatory in XDS mode)

Cross Sdk ID to use to build project
XDS_AGENT_URL

Local XDS agent url (default

http://localhost:8800

)

Configuration variables set within gdb init command file
Above

XDS_xxx

variables may also be defined within gdb init command file (see --command or -x option of genuine Gdb).

You must respect the following syntax: commented line including

:XDS-ENV:

tag

Example of gdb init file where we define project and sdk ID:
# :XDS-ENV: XDS_PROJECT_ID=4021617e-ced0-11e7-acd2-3c970e49ad9b
# :XDS-ENV: XDS_SDK_ID=c226821b-b5c0-386d-94fe-19f807946d03
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How to build xds-gdb from scratch
Dependencies
Install Go and some other tools.
Refer to Prerequisites chapter for more details.

Building
Clone sources under

$ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds/xds-gdb

in order respect directory hierarchy that

match Go package import logic (see How to Write Go Code for more details).
Then use delivered Makefile :
# Declare ROOTDIR, can be any location (for example xds-build)
ROOTDIR=$HOME/xds-build
# Create directory hierarchy that match Go package import logic
mkdir -p $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
cd $ROOTDIR/src/gerrit.automotivelinux.org/gerrit/src/xds
# Clone sources
git clone https://gerrit.automotivelinux.org/gerrit/src/xds/xds-gdb
# or git clone ssh://YOUR_USERNAME@gerrit.automotivelinux.org:29418/src/xds/xds-gdb
# Build xds-gdb
# (note that GOPATH will correctly be set by Makefile)
cd xds-gdb
make all

Generate xds-gdb package / tarball
make package-all
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Debugging
XDS gdb architecture
This tool is written in Go.
|
+-- bin/

# where xds-gdb binary will be built

|
+-- gdb-XXX.go

# xds-gdb Go sources

|
+-- conf.d/

# Linux configuration and startup files (systemd user service)

|
+-- glide.yaml

# Go package dependency file

|
+-- LICENSE

# XDS gdb license

|
+-- main.go

# main entry point (Go)

|
+-- Makefile

# makefile including

|
+-- README.md

# readme

|
+-- scripts/

# hold various scripts used for installation

|
+-- vendor/

# temporary directory to hold Go dependencies packages

Debug
Install first Visual Studio Code and Go plugin (

ext install lukehoban.Go

Visual Studio Code launcher settings can be found into

)

.vscode/launch.json

.

Please follow instructions of xds-agent debugging chapter, knowing that you execute these same instructions in

xds-gdb

repo, in

other words by replacing xds-agent references by xds-gdb.
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